Creating Certus-NX-RT Project in Radiant
Software

PRODUCT NAME MANUFACTURER PART NUMBER DEVICE TYPE
Lattice Certus-NX-RT FPGA uT24C407 RLO1

Table 1: Cross Reference of Applicable Products

1.0 Overview

rRONTGRADCE

This document details the process of creating a Certus-NX-RT FPGA project using the Lattice Radiant software
tools and the Lattice Certus-NX Versa Evaluation board LFD2NX-VERSA-EVN.

For the purposes of this document, create a project named led_brightness and configure the Radiant tools to
include all the source modules required for a successful build.

Using this template, projects are created using:

(a) the preferred application source directory structures and
(b) the directory structure for the Radiant-supplied files.
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Figure 1 shows the block diagram of the design, it includes:

e the DIP switch inputs DIP_SWI[4:1] which control the duty cycle to the PWM output, which in turn controls the
brightness to LED[0]

e the LED[7:0] outputs controlled by 7 bits of the design’s internal 32-bit counter “count” and are used to show
the heartbeat of the system. The counter’s bits [30:24] drive the LED[7:0]

e the S_SEG[7:0] outputs are also controlled by 4 bits of the internal 32-bit counter “count” and are used to drive
the board’s 7-segment LED device. Specifically, the counter’s 4 bits [30:27] are decoded in such a way as to
drive the 7-segment LED display’s control signals S_SEG[7:0] as a hexadecimal counter with the decimal point
LED also being turned on whenever the count value equals F hex.
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Figure 1: An Example Netlist View
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3.0 Creating a Design Project with Radiant Software

1. Download CreatingRadiantProject.zip from caes.com.

2. Launch Radiant Software D

3. From the File menu, select New > Project....
4. Specify the project name as led_brightness, navigate to the location of your choice and click Next, see
Figure 2.
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New Project X

Project Name
Enter a name for your project and specify a directory where the project data files will be stored.

Project:
Name: led_brightness|
Location: = C:/projects/Lattice/Certus-NX-RT/applications/led_brightness - Browse...

Project will be created at C:/projects/Lattice/Certus-MNx-RT/applications/led_brightness/| Create subdirectory

Implementation:

Mame: impl_1
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Location: = C:/projects/Lattice/Certus-NX-RT/applications/led_brightness/led_brightness/impl_1

< Back Next = Cancel Help

Figure 2: Creating a Radiant Design Project
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5. Select Add Source... and click Open, see Figure 3 and Figure 4, click Next.
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Import File X
T « Lattice > applications > led_brightness > src v O D Search src
Organize ¥ New folder =~ I @
~ Name Date modified Type Size
* :
i E] debounce 1/10/2022 4:25 PM Verilog File Type" 3 KB
1 E] pwm 1/10/2022 4:25 PM Verilog File Type" 2KB
&] pwm_led_brightness_top 1/10/2022 4:25 PM Verilog File Type” 3KB
File name: | “pwm_led_brightness_top” “debounce” “pwm™ ~ ‘ Input Files (*.vhd *.v *.sv *.h *ipx» ~

Figure 3: Selecting Sources

New Project X

Add Source
Add HDL, constraint or other files.

Source files: Add Source...

C:/projects/Lattice/Certus-NX-RT/applications/led_brightness/src/debounce.v
C:/projects/Lattice/Certus-NX-RT/applications/led_brightness/src/pwm.v
C:/projects/Lattice/Certus-NX-RT/applications/led_brightness/src/pwm_led_brightness_top.v
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Copy source to implementation source directery
Create empty constraint files

< Back Next = Cancel Help
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Figure 4: Adding Sources
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6. Select the appropriate device, click Next and choose Lattice LSE; click Next and Finish, see Figure 5.

Select Device
Specify a target device for the project.
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Select Device: Device Information:
Family: Device: Caore Voltage: 100V
iCE40UP (iCE4D UltraPlus) LFD2NX-17 Logic Cells: 39000
| | I LAV-AT (Lattice Avant) LFD2NX-40 Lires DIET
LFCPNX (CertusPro-MNX) Registers: 32256
I_ LFD2MX (Certus-NX) EBR Blocks: 84
o LFMXO5 (MachX035-NX) LRAM: 2
LIFCL (CrossLink-MNX) DSP (18x 18 Multiplier): 56
Z ADC Blocks: 1
PLLs: 3
DLLs: 2
2 ] D PCSs: 1
O Operating Condition: Package: b L
DPHYs: 0
— Commercial ~ | | CABGAZSE - PIO Cells: 185
I— Performance Grade: PIO Pins: 185
< 9_High-Performance_1.0v hd
( ) | Part Mumber:
LFD2NX-40-9BG256C 7
b
J Online Data Sheet for Device
D— < Back MNext = Cancel Help
Figure 5: Selecting the FPGA Device
New Project x
Select Synthesis Tool
Spedify a synthesis tool for the implementation.
Synthesis Tools:
Synplify Pro
@ Lattice LSE

Figure 6: Selecting the Synthesis Tool

7. The initial project with the provided files should look like Figure 7.
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Lattice Radiant Software - Reports - x
File Edit View Project Tools Window Help
o =) . - m =
- & A QQaaQ E AL @ FPEEEBRqG@EE GBS M
> u ‘Synthesize Design u Map Design u Place & Route Design u Export Files B
= [F] led_brightness S xa 1Y start page =1 Reports i
I LFD2NX-20-08G256C
- £ Strategies Lod briahtness Proiect S
s ed_brightness Project Summa
) Area Reports _brig ) "y
1] Timing Implementation Name impl_t Performance Grade 9_High-Performance_1.0v
=]
7 Strategyl Strategy Name Strategy Operating Condition com
= [ impl_1 (Lattice LSE)
Part Number. LFD2NX-40-9BG256C Synthesis: Lattice LSE

~ M Input Files » | Synthesis Reports
2] source/impl_1/debounce.v Family LFD2NX Timing Errors.

) source/impl_1/pwm.y

» () Map Reports Device: LFD2NX-40 Project Created 2022/03/18 09:15:00
] source/impl_1/pwm_led_brightness_top.v P Rep
= B3 Pre-Synthesis Constraint Files Package CABGA256 Project Updated 2022103/18 09:15:01
»
Lattice LSE Place & Route Reports Project File Cprojects/Lattice/Gertus-NX-RT/applications/led_brightness/led_brightness/led_brightness.rdf
Synplify Pro
" " Implementation Location C:/projects/Lattice/Certus-NX-RT, brightness/led. fi I_1
source/impl_1/impl_1.sdc » " Export Reports
« [ Post-Synthesis Constraint Files I
source/impl_1/impl_1.pdc N Resource Usage
- * |1l Misc Reports 9
ebug Files
>~ LUT4 0 10 Buffers 0
Script Files
Analysis Files PFU Register 0 EBR 0

Branrammina Filec
~ 1} pwm_led_brightness_top - pwm_led_brightness_top.v x
1} pwm_gen(pwm_gen_inst1) - pwm.y

1} debounce(debounce_inst3) - debouncev

1} debounce(debounce_inst2) - debouncev =
prj_create -name "led brightness" -impl "impl 1" -dev LFD2NX-40-9BG256C -performance "9_High-DPerformance 1.0V" -synthesie "lse” B
/projects/Lattice/Certus-NX-RT/applications/led brightness/led brightness/led brightness.rdf

prj_add_source " projects/Lattice/Certus-NX-RT/applications/led_brightness/led brightness/source/impl_1/impl_l1.sdc" "C:/projects/Lattic
file copy -force -- "C:/projects/Lattice/Certus-NX-RT/applications/led brightness/src/debounce.v" "C:/projects/Lattice/Certus-NX-RT/appli
pri_add_source "C:/projects/Lattice/Certus-NX-RT/applications/led_brightness/led brightness/source/impl_l/debounce.v" "C:/projects/Lattic
pri_save

1} debounce(debounce_inst1) - debouncey

1} debounce(debounce._inst) - debouncey

a/vVvVYVav

[ FleList [E] Source Template Td Console = output E¥ Message

1P Catalog

Figure 7: An Example of an Initial Project
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8. From the IP Catalog Architecture Modules, add a PLL module with the options shown below and name it
pwm_pli3, see Figure 8 and Figure 9.
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| Module/IP Block Wizard X

Generate Component from Module pll Version 1.7.0
This wizard will guide you through the configuration, generation and instantiation of this Module/TP. Enter the following
information to get started.

Componentname:  pwm_pll3|

Create in; C:fprojectsfLattice [Certus-NY-RT fapplicationsled_brightnessled_brightness Browse...

Mext = Cancel

Figure 8: Opening the IP Catalog
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=] Module/IP Block Wizard

Configure Component from Module pll Version 1.7.0
Set the following parameters to configure this component.

Diagram pwm_pll3

pwm_plI3
e \
clkop_of—
—clki_i P-
clkos_o—
—rstn_i
lock_of—
. J
pll

Configure pwm_pll3:

General Optional Ports
Property Value
Configuration Mode Frequency
Enable Fractional-M Divider
Enable Spread Spectrum Clock Generation
Enable User Feedback Clock
Enable Internal Path Switching
~ Reference Clock
CLKl: Frequency (MHz) [18 - 800] 100
Enable Reference Clock Monitor
~ Feedback
CLKFE: Feedback Mode CLKOP
* Primary Clock Qutput
CLKOP: Frequency Desired Value (MHz) [10 - 800] 25
CLKOP Tolerance (%) 5.0
CLKOP: Enable Trim for CLKOP
~ Secondary Clock Qutput
CLKOS: Enable ]
CLKOS: Bypass
CLKOS: Frequency Desired Value (MHz) [6.25-800] 10
CLKOS Tolerance (%) 0.2
CLKOS: Static Phase Shift (Degrees) 0

CLKOS: Enable Trim for CLKOS
~ Secondary Clock Output (2)
CLKOS2: Enable
¥ Sarandary Clark Oodnot (21

Mo DRC issues are found.

< Back Generate

-

Calculate

e

Cancel

Figure 9: Adding a PLL from the IP Catalog

9. Once the PLL options are entered, click the Generate button to start the creation of the module.
10. ON the next screen, click the Finish button to complete the creation of the module.
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11. Once the PLL is created, it is added to the project files, see Figure 10.
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Lattice Radiant Software - Reports - X

Fle Edit View Project Tools Window Help
¢-=T- B O Qe EFE nl HEERBE GOEE
> u ‘Synthesize Design u Map Design u Place & Route Design u Export Files B

&
=
b
2l

A oxa
= [ led_brightness e & @ start page = Reports [E
LFD2NX-40-98G256C
= [ Strategies ) 3
= aren Reports Led_brightness Project Summary
& Timing Implementation Name: impl_1 Performance Grade: 9_High-Performance_1.0V
]
7 Strategyl _ Strategy Name Strategy1 Operating Condition com
~ 2 impl_1 (Lattice LSE)
Part Number. LFD2NX-40-9BG256C Synthesis: Lattice LSE
- [ Input Files »

Synthesis Reports
] source/impl_1/debounce.y Family LFD2NX Timing Errors:

) sourcefimpl_1/pwm.y

» %) Map Reports Device: LFD2NX-40 Project Created 2022/03/18 09:15.00
©._source/impl_1/pwm_led_brightness_top.v P Rep
J) pwm_pli3/pwm_pll3 ipx Package CABGA256 Project Updated 2022/03/18 09:15:01
»
» RTL Files Place & Route Reports Project File G/projects/Lattice/Certus-NX-RT/applications/led_brightness/led_brightness/led_brightness.raf
+ [ Constraint Files
Implementation Location C:/projects/Lattice/Certus-NX-RT, brightness/led. /i _1
» [ Testbench Files » "1 Export Reports
pwm_pli3.cfg I
~ [ Pre-Synthesis Constraint Files i Resource Usage
» [l Misc Reports 9
Lattice LSE
" LUT4 0 10 Buffers: 0
Synplify Pro
source/impl_1/impl_1.sdc PFU Register: 0 EBR 0
- Pnct-Sunthecic Cnnctraint Filec -
~ 1} pwm_led_brightness_top - pwm_led_brightness_top.v x

v 1} pwm_pl3(pwm_plI3_inst) - pwm_pli3.v
1} pwm_gen(pwm_gen_inst1) - pwm.v

»
prj_add_source "C:/projects/Lattice/Certus-NX-RT/applications/led _brightness/led_brightness/source/impl_1/impl_1l.sdc" "c:/pmject.s/La:);ig-
file copy -force "C:/projects/Lattice/Certus-NX-RT/applications/led brightness/src/debounce.v" "C:/projects/Lattice/Certus-NX-RT/appll
pri_add_source "C:/projects/Lattice/Certus-NX-RT/applications/led brightness/led brightness/source/impl_1/debounce.v” "C:/projects/Lattic
pri_save
prj_add_source "C:/projects/Lattice/Certus-NX-RI/applications/led brightness/led_krightness/pwm_pll3/pwm pll3.ipx"

1} debounce(debounce _inst3) - debouncey

(

1 debounce(debounce_inst2) - debouncey

1} debounce(debounce_inst1) - debouncey
(s

1} debounce(debounce_inst) - debouncey

VYV VYV YA

[ FleList [E] Source Template |Z] IP Catalog Td Console = output E® Message
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Figure 10: Looking at the Recently Added PLL IP
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4.0 Compile Design using Radiant Software
4.1 Set Top Level File

12. From the Project menu, select Active Implementation > Set Top-Level Unit... and set
pwm_led_brightness_top.v as the top level file, see Figure 11.

Project Properties X

- |:| led_brightness
ﬂ LFD2NX-40-9BG256C

+ [ impl_1

Name: pwm_led_brightness_top.v Category: ~ Resource
Location:  atfice/Certus-NX-RT/applications/led_brightness/led_brightness/source/impl_1

i.| source/impl_1/debounce.v

N Val
L| source/impl_1/pwm.v ame alue

[ sourceﬂmpl_1;’pwm_led_bnghtness_ Verilog Standard = <inherit from implementation=

#| pwm_pli3/pwm_pli3.ipx Include for Synthesis and Simulation

source/impl_1/impl_1.pdc
source/impl_1/impl_1.sdc

=

| Area
—

2= Timing

ij Strategy1

oK Cancel

Figure 11: Setting a Top Level File
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4.2 Synthesize Design

13. Synthesize the design by clicking on the Synthesize Design arrow, see Figure 12.

Lattice Radiant Software - Reports — X

File Edit View Project Tools Window Help

=
s-&-B 9 QQaa
> O oo | recesrosecsn | somee | [

= [ led_brightness 2 xa 1Y start Fage =1 Reports L
8 LrD2NX-20-98G256C
~ [ Strategies Led brignts Project s
— e il ness Project Summai
T Area Reports -brig g Y
5] Timing Implementation Name impl_1 Performance Grade 9_High-Performance_1.0V
I
7 Strategyl _ Strategy Name Strategy Operating Condition com
~ 2 impl_1 (Lattice LSE)
- BB Ineut Fil Part Number. LFD2NX-40-9BG256C Synthesis: Lattice LSE
W=n8lEs » [ Synthesis Reports
2] source/impl_1/debounce.v Family LFD2NX Timing Errors
2] source/impl_1/pwm.y
» " Map Reports Device LFD2NX-40 Project Created 2022/03/18 09:15.00
©. source/impl_1/pwm_led_brightness_top.v
- [ pwm_pli3/pwm_pli3ipx Package CABGA256 Project Updated 2022/03/18 09:15.01
»
» RTL Files Place & Route Reports Project File C:/projects/Lattice/Certus-NX-RT/applications/led_brightness/led_brightness/led_brightness.rdf
» [ Constraint Files
—— Implementation Location C fprojects/l atlice/Certus-NX-RT, lled_brightnessfled_brightness/impl_1
» restbench Files | » () Export Reports
pwm_pli3.cfg
= [ Pre-Synthesis Constraint Files ) Resource Usage
R » || Misc Reports 9
attice
LUT4 63 10 Buffers: 13
Synplify Pro
source/impl_1/impl_1.sde PFU Register. 137 EBR 0
- Prct-Qunthesic Canctraint Filae hd
~ 1} pwm_led_brightness_top - pwm_led_brightness_top.v x

+ 1 pwm_plI3(pwm_plI3_inst) - pwm_pli3.y
1% pwm_gen(pwm_gen_inst1) - pwm.v

»
1} debounce(debounce_inst3) - debouncey

file copy -force
prj_add_source "
pri_save
prj_add_source "C:/projects/Lattice/Certus-NX-RT/applications/led_brightness/led_brightness/pwm_pll3/pwm_pll3.ipx"
pri_run Synthesis -impl impl_1

"C:/projects/Lattice/Certus-NX-RT/applications/led_brightness/src/debounce.v"” /proj ects/Lattlce/certus—N’X—RT/aglk -

I} debounce(debounce_inst2) - debounce. projects/Lattice/Certus-NX-RT/applications/led brightness/led brightness/source/impl 1/debounce.v" "C:/projects/La

(

(6 c
1 debounce(debounce_inst1) - debouncey

(

1% debounce(debounce_inst) - debouncex

VVV VYV A

Td Console [= output E® Message

Figure 12: Synthesizing the Design
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4.3 Pin Assignment (Device Constraint Editor)

14. Once the design has been synthesized, use the Device Constraints Editor option of the Tools drop down
menu to assign the pin numbers to their respective signals, see Figure 13.
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Device Constraint Editor
File Edit View Design Window Help

B 5¢ aaaeaq

m Q~ Find ...
I + 2= Ports EIS 14131211109 8 7 6 5 4 3 2 1
I_ {7 Instances(ee) » EEEEEEEEECCOCO8[E
E L s I [E|E EEE EEEEEEEERE
o L] ] 18] (8] 8] [=)] [S][=] B S =] E] =] s 6
. W i) o 15 e | My i | N e Vs i
Name GroupBy  Pin BANK  I0_TYPE DRIVE  PULLMODE = CLAMP  DIFFDRIVE DIFFRESISTOR GLITCHFILTER HYSTERESIS OPENDRAIN
Z @ - = AllPort N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A
v [ Input R/A N/A N/A /A N/A N/A R/A R/A N/A M/A R/A R/A
Z o] v @& Clock R/A N/A N/A /A N/A N/A R/A R/A N/A M/A R/A R/A
D [ CLK CUSTO... | N/A H11 2 VCMOS33 NA DOWN aN NA OFF aN aN QFF
O [ DIP_SW[1] N/A L10 3 LVCMOS515H NA up aN NA OFF OFF aN QFF
[ DIP_SwW[2] N/A E16 0 LVCMO518 NA DOWN aN NA OFF aN aN QFF
H % = DIP_SW[3] R/A L 3 LVEMOS15H NA up ON NA OFF OFF ON QFF
P E [ DIP_SW[4] R/A R3 4 LVEMOS15H NA up ON NA OFF OFF ON QFF
~ 1 Output N7A N/A N/A N/A N/A N/A N7A N/A N/A N7A N7A N7A
< ﬁ} T LED[O] N7A B3 2 VCMOS33 8 NONE QFF NA OFF OFF NA QFF
‘ ’ I LED[1] N/A A2 2 VCMOS33 8 NONE OFF NA OFF OFF NA OFF
T LED[2) R/A H16 2 LVCMOS33 8 NOMNE QFF NA OFF OFF NA QFF
H O LED[3] R/A B2 2 LVCMOS33 8 NOMNE QFF NA OFF OFF NA QFF
I T LED[4] N/A H15 2 VCMOS33 8 NONE QFF NA OFF OFF NA QFF
& T LED[S] N/A H14 2 VCMOS33 8 NONE QFF NA OFF OFF NA QFF
T LED[B] N/A H12 2 LVCMOS33 8 NONE QFF NA OFF QOFF NA QFF
& @ LED[7] R/A ns 2 LVCMOS33 8 NOMNE QFF NA OFF OFF NA QFF
o 5_SEG[0] R/A Gl 1 LVCMOS33 8 NOMNE QFF NA OFF OFF NA QFF
< 71 S_SEG[1] N/A G14 1 VCMOS33 8 NONE QFF NA OFF OFF NA QFF
71 S_SEG[2] N/A G12 1 VCMOS33 8 NONE QFF NA OFF OFF NA QFF
o S_SEG[3] R/A Gn 1 LVCMOS33 8 NOMNE QFF NA OFF OFF NA QFF
o1 5 SEG[4] R/A E12 1 LVCMOS33 8 NOMNE QFF NA OFF OFF NA QFF
o S SEG[5] R/A E10 1 LVCMOS33 8 NOMNE QFF NA OFF OFF NA QFF
71 5_SEG[E] N/A E9 1 VCMOS33 8 NONE QFF NA OFF OFF NA QFF
71 S_SEG[T] N/A Fg 1 VCMOS33 8 NONE QFF NA OFF OFF NA QFF

Figure 13: Performing Pin Assignment
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4.4 Compile Design

15. Compile the design by clicking on the Run All arrow, see Figure 14.

are - Device Constraint Es - X

File Edit View Project Design Tools Window Help

rRONTG

= e = v
o5~ B QQaQaae M
E | o Expart Fies completed.
Qe FndText 1} start Page I Reports [ pevice constraint editor IE]
Bottom View : LFD2NX-40- CABGA256 e @a
O |[Q FnaText
= [ led_brightness = » Visible Banks
9 LFoan40-086256C » 3 Ports 1413121110 9 8 7 6 5 4 3 2 1 > [ AlPIOs
- B3 Strategies > P Instances(zt) A EEEECORCDOE » [ Test and Programming/Configuraton
I I I =3 = = B seRDES
) aven il Nes 8 i EIREB OO + B Powersuppiies
[l Timing c BB B C|O|80|C|E|O)R)
[7 strategyt D O & | 5| B EH OIS
~ 172 impl_1 (Lattice LSE) - E ORBEEOCOOOD
~ 3 Input Files = F O | B LENC ) E(CR S
1} source/impl_1/pwm_led_brightness_top.v B 6 18 [8][ElE] @] e 8] 8
4} source/impl_/pwm.y = H @0 BEEDECIOOE
3} source/impl_1/debouncex o 3 [&] (][0 5] [ 5 5] ) o
~ |t} pwm_pli3/pwm_pli3.ipx Name BANK | 10_TVPE DRVE  PULT
» £ RTL Files = .
[ + 5 anport NAN/A WA N
» £ Constraint Files —
T —— & v I Input WA N/A WA N/A
Z pwm_pll3.cfg v @ Clock N/A N/A WA N/A WA N/A
- Pre-Synthesis Constraint Files ® CLK_CUSTO. N/A HIT(H1Y) 22) VCMOS33) NA(NA) | DOV,
Lattice LSE
ool ALt i®  DIP_SW[1] NAA L1010y 33)  LVCMOSISH(IVCMOSTSH)  NA(NA) UP(L
source/impl_1/impl_1.sdc
* 7 Post-Synthesis Constraint Files [ DIPSWI2] NiA ET6(E1E) LVCMOS12(LVCMOS Tg) NA(NA) | DOV
source/impl_1/impl_1.pde [ DIPSWI3] NiA AL LVCMOSISHIVEMOSTSH)  NAINA) | UP(L
H Debug Files [ DIP_SWI4] NA RIR3) LVCMOSISHIVEMOSTSH)  NAINA) | UP(L
~ 9 Script Files
") led_brightness_sim/led_brightness_sim.spf ~ ) G A WA A NA WA
Analysis Files < LEDio] NAA 83(83) 22) NOM
>l Programming Files 1 LED(T] NA A2(R2) 22) VCMOS33) ( Non
sourcefimpl_1xcf
= fimpl. 7 LeDz) NAA HI6(H16) 22w VCMOS33) @ | Non
‘ >
~ % pwm_led_brightness_top - pwm_led_brightness_top x Y~ Fiter Fort Pin Giobal 550 Selecton Atibutes
v g pwm_pll3(pwm_pll3_inst) - pam_pl3¢ T - @ ERROR: 0 WARNING: 128 | @ INFO: 62 | H GroupbyD | | search 2 %
H pwm_gen(pwm_gen_inst1) - pwm.y =
1} debounce(debounce_inst3) - debounce.y Place & Route (8 warnings, 1 info)
I 70001944 WARNING - No master clock for generated clock create_generated_clock -name {pwm_clk] -source [get_pins (pwm_pli3_inst/Isce_pll_inst/gen_no_refelk_mon.u_PLLPLL_inst/REFCK]] -divide_by 4 [get_pins {pwrm_plI3_inst/lscc_pllinst/
1} debounce(debounce inst2) - debounce.v o 9
. gen_no_refelk_mon.u_PLLPLL inst/CLKOP }]
£ debounce(debounce_inst1) - debounce.v © 62244000 INFO - The external feedback signal pwm _clk for PLL_CORE instance pwm_pll3_instlsce_pll inst.gen_no_refelk_mon.u_PLLPLL inst will use the primary clock netwaork.
debounce(debounce_inst) - debounce
a o (  inst) ~ Export (1 info)
© 1191031 INFO - Design IBIS models are generated for board level analysis.
& O Fleust [ source Template 1] 1P Catalog E output 57 Message
.
< Figure 14: Compiling the Design
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4.4 Simulate Design

16. From the Tools menu, select Simulation Wizard and click Next, see Figure 15.

rRONTG

Lattice Radiant Software - Netlist Analyzer - X
File Edit View Project Design Tools Window Help
— Eﬂ - ., @ pre-synthesis Constraint Editor
© @ Post-Synthesis Timing Constraint Editor
> Device Constraint Editor R
E tFi ted,
Netlist Analyzer part s campe
Er— Physical Designer 0 Stortpoge ) Reports =
ECO Editor b 5 Instances(17) =
~ [ led_brightness BB Timing Analyzer » 2= Portsd)
I LFD2NX-40-9BG256C “§ Reveal Inserter b Nets(10)
+ [ strategies 3 Reveal Analyzer/Controller » (B Clocks(12)
[] Area @ Power Calculator
= 3
] Timing B Progammer : I
4 Strategyt SEl Editor i
v (7% impl_1 (Lattice LSE) D standalone Timing Analyzer [N |
™ 3 Input Files Bitstream Security Settings o o 1
%) source/impl_1/pwm_ o . ax -
Run Manager 2 o -y
sourcefimpl_1/pwm.y S SEG[70)
o PLUPY™Y I Simulation Wizard - Dol
%) sourcefimpl_1/debou o
[ pwm_pli3/pwm_pii3.i = Source Template 2 e
+ B R Fres [ 1P Catelog z : iy ot
» Constraint Files b= T LO00I0OINN0N00NN0N000000000001L, dock
= G a2
N Testbench Files | ™I ModelSim Lattice-Edition = ol P ——
pwm_pl.cfg Clear Tool Memory.
v [ Pre-Synthesis Constraint | Options.
Lattice LSE
source/impl_1/impl_1.sd L
* [ Post-Synthesis Constraint Files =
source/impl_1/impl_1.pdc @®
Debug Files
e —
I I ~ [ Script Files
] led_brightness_sim/led_brightness_sim.spf
wleosi 108
Analysis Files e —
~ £ Programming Files
. som:n 102 e
| source/impl_1.xcf =52
>
‘ y
v ZF pwm_led_brightness top - pwm_led_brightness_top.v x RTL Netfist - pwm_led_brightness_top/work (1/1)
» L3 pwm_pll3(pwm_pll3_inst) - pum_pll3.v T v ©mromo0 | 4 wARDNG: 128 | O 0062 | BGropbyD | search A x
ZF pwm_gen(pwm_gen instl) - pwmv B}
I debounce(debounce_inst3) - debounce. Place & Route (@ warnings, 1 info)
H £ debounce(debounce ins®) - debouncear R 0001943 WARNING - No master clock for generated clock creste_generated_clock -name (pwm_elk} -source [get_pins (pwm_pi3_inst/lcc_pil inst/gen_no_tefclk_men.u_PLLPLL nst/REFCK|] -divide_by 4 [get_pins [pwm_pl3_inst/lcc_pl inst/
gen_no_refclk_mon.u_PLLPLL inst/CLKOP }
I £ debounce(debounce_inst1) - debounce © 62224000 INFO - The external feedback signal pwm,_clk for PLL_CORE instance pwm_plI3_instlscc._pll_inst.gen_no_refclk_mon.u_PLLPLL inst will use the primary clock netwark.
I} debounce(debounce inst) - debounce.y
~ Export (1 info)
& © 1191031 INFO - Design IBIS models are generated for board level analysis.
< Figure 15: Simulating the Design
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Creating Certus-NX-RT Project in Radiant
Software

17. Name the project led_brightness_sim and click Next, see Figure 16. If asked whether you want to create
it, click Yes. Click Next to Add and Reorder Source and Parse HDL files for simulation. Click Finish to
start the simulation.

L - Ne e -
File Edt View Project Design Tools Window Help

-5 R 9HC eaaea =5H mk

> Sy | [ Export Files completed

[oTa— £ 1D StartPage I Reports 2
b i Instances(17) A
~ [0 led_brightness o’ 2= Portsd) s s
1 LFD2NX-40-0BG256C = [ Nets(10)
~ [ Strategies = v i Clocks(12)
[] Ares
[=] Timing + Simulation Wizard X
[i7 strategy1 x
.=, y Simulator Project Name and Stage
/7 impl_1 (Lattice LSE) [y Enter name and directory for your smuiation preject. Choose simulator and the process stage you
- B3 Input Fles wish to simuiate. Avaiable stages are automaticaly dsplayed.
1) source/impl_1/pwm_led_brightness top.y O o
- ®
%) source/impl_1/pwmav Projectname:  led_brighiness_sm
) source/impl_1/debounce {
. 2 t | Cfprofects Lattce/C T  brightness | | Bromse... E e n 102
) pwm_pli3/pwm_pli3ipc . om0 e
» £ RIL Files - Simuator y
+ [ Constraint Files = @ ModelSim b = IO
» [ Testbench Fles L
pwm_plB3.cfg Process Stage
- Pre-Synthesis Constraint Files. ® RTL (Sl tas
Lattice LSE -
source/impl_1/impl_1.sdc [hd Post Route Gate-Level = PR
~ [ Post-Synthesis Constraint Files. R T i I
source/impl_1/impl_1.pdc
Debug Files
v [ ScriptFiles
4 led_brightness_sim/led_brightness_sim.spf 1
o n a0
Analysis Files <sdk || next> || cancel w000 s
~ 7 Programming Files
1 sourcefimpl_1.xcf 2 Pt
‘ ’
~ £} pwm_led_brightness_top - pwm_led_brightness_top.v x L Netist - pwm_led_brighiness_topjvart (1/1)
» 113 113 inst) - i
i pom_pitpwen_pil.nt) - prn_pltzv T v | @ ERROR:0 WARNING: 128 @ INFO: 62 | FGrowpbyD || Search [Ealp

T} pwm_gen(pwm_gen_inst!) - pwm.v 4
~ Place & Route (B warnings, 1 inf
T} debounce(debounce_inst3) - debouncey ace & Route (B warnings, 1 info)

T} debounce(debounce inst?) - debouncev

£ debounce(debounce_inst1) - debounce

, 4 TO0D1S44WARNING - No master clock for generated clock create_generated_clock -name {pwm_clk} -source [get_pins {pwm_plI3 inst/lsce_pll inst/gen_no_refclk mon.u_PLLPLL inst/REFCK]] -divide by 4 [get_pins {pwm_pli3_inst/lsce_pil inst/
gen_no_refclk_mon.u_PLLPLL inst/CLKOP 1.

© §2244000 INFO - The external feedback signal pwm_clk for PLL_CORE instance pw_pll3_inst lsce_pll inst.gen_no_refelk_mon.u_PLLPLL inst will use the primary clock network.
~ Export (1 info)
© 111031 INFQ - Design IBIS models are generated for board level analysis,

£ debounce(debounce inst) - debouncew

Figure 16: Naming the Simulation
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18. When finished, ModelSim will open and run the simulation, see Figure 17.

rRONTG

M ModelSim Lattice FPGA Edition 20214 - X
File Edit View Compile Simulste Add Transcript Tools Layout Bookmarks Window Help
|8 @@ @ inaos o arE| vPEAN]| Yteas e EAEHEe  pue| etk 8] wefme =] ] ctetarest rscoumms EIEEEEE
8 ~ ; N T Se - oE - B & & ) -
InE I Eh R EFTYIEY AT
& sim - Defauit H ) x| §u Objects EE RN i EERET
e st _ssnuntspe[rpCotngry sy _omicoesoe | | [vhams Ee, | R [
j‘ pwm_led_brightne... pwm_led_b... Module DU Instance N, £ jpwm_led_brightness_top/CLK_CUSTOMER 1
(-l pam pl3inst  pam_pl3  Module DU Instance ) |ed_brighiness_top/DIP_SW
it 5 pwm_gen inst... pwm_gen  Module DU Instance B e
+ o debounce_inst  debounce  Module DU Instance — =
T_; o debounce_inst... debounce  Mockie DU Instance e e
Vodde U Instance B Jowm_led_brighiness_topjcompare
Modki DU Instance Intemal e
Process . Internal Jowm_led_brighiness_top/owm_out
Process - Intemal [pwm _led _brightness_top/pwm_ck
Process - Intemal Jpwm_led_brightness_top/LED_OUT
Process - _Infemal Jowm_led_brighiness_topjcount

@ #ASSIGN#80  pwm_led b... Process -
@ FALWAYSZ82  pwm_ed b... Process -

Jpw_led_brichtness_top/S_SEG_reg

@ #ALWAYS#10.., pwm_led b... Process - £ Processes (Active) ——— H el x|
o std std ViPackage Package *[Name [Type Gftered)  |state[order | -
|2 #vsim_capacity # Capacity Statistics
4l _ L -
[0 Crary T Project | B Memory List | & sm FEIR |

3 Transarpt

Loading vwork.pwm_led brightness_top
Loading vork.pwm pll3
Leading vozrk.pwm_pll3_ipgen_lscc pll
Loading
Loading
Leading
Loading
Loading
Leading ovi_lfd2nx.gpll pll lmmi
Loading ovi_lfd2nx.gpll_core
Loading ovi_lfd2nx.gpll_lmmi_pinshorter
Leading ovi_lfd2nx.lumis_clkcst
Loading ovi_lfdznx.gen_cell clk_gate
Loading ovi_lfd2nx.gen_cell _clk_mux2l
Leading ovi_lfd2nx.gen_cell latz
Loading ovi_lfd2nx.rstSync
Loading ovi_Lfd2nx.lmmis_fsm
Leading ovi_Lfd2nx.VEI
Loading ovi_lfd2nx.VLO

B e kR R

4 Warning: (vsim-2635) [TFMEC] - Too few port connections for 'pum pll3_inst'. Expectsd 5, found 3
Time: 0 £s Iceration: 0 Instance: /pwm_led brightness_top/pwm p1l3_inst File: C:/projects/Lattice/Certus-NE-RT/aprlicat: Led ) 1ed_bright: source/impl_L/pwm_led brightness_top.v Line: 115
(vsim-3722) C:/projects/Lattice/Certus-NK-RT/applications/led brightness/led brightness/source/impl_1/pwm led brightness_top.v(LlS): [TEMEC] - Missing connection for port 'rstn_i
(vsim-3723) C:/projects/Lattice/Certus-NX-BT/applications/led brightness/led brightness/source/irpl 1/pvm led brightness top.v(L1S): [TEMEC] - Missing connection for port 'lock o'
*4 Warning: (veim-301%) [PCDEC] - Port size >) does not match vion size ») for >
Time: 0 fs Iteration: 0 Erotected: /pwm_led brightness_top/pwn_pll3_inst/lscc_pll_inst/gen_no_refclk_mon/u_PLL/PLL_inst/<protected> File: nofile Line: 196
main_pane.wave.interior.cs.body.pw.wE -l

Figure 17: The ModelSim Simulation Wave View
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5.0 Program the Device with Radiant Programmer

19. Make sure that in the Lattice Certus-NX Versa Evaluation board LFD2NX-VERSA-EVN:
20. there is a USB cable connecting the computer to J2

21. there is a 12V power supply connected to J35

22. From the Tools menu, select Programmer and a new window opens, see Figure 18.

rRONTGRADCE

8B Reciont Programmen - impl_Txc -
BeEd BUG BB
Encble Status  Device Famity Device Operation File Name File Date/Time Checksum USERCODE Cable Setup 8 x
1& -LFDZNX Dunmxran Fast Configuration C:/projects/Lattice/Certus-NX-RT/ Jled_bii fled_brightness/impl_1/led_brightness impl_1.bit 07/2310:10:28 0x00000000 Cable Settings
Detect Cable
Cable: HWUSENZ8 (D) -
Port: FTUsE0 v
Custom port

Programming Speed Settings
@ Use default Clock Divider
O Use custom Clock Divider

TCK Divider Setting (0-30x): [1_ %
1/0 Settngs

(@ Use default /0 settings
O Use custom 1/0 settings

LLI
|_
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=
=
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o
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TeK SetTRST high
SetTRST low
PCICOMPUTER ; &
DOWNLOAD CABLE PROGRAMN pin connected
CPUMICROPROCE SSOR TCK THS
iSPEN pin
™I LFD2NX-40
TDI TOO SetispEN high
RESET TAGLEN SetispEN low
Debug Mode.
Output -3
.
INFO - JTAG Chain Verification. No Errors.
INFO - Check configuration setuy
INFO - Device 1 LFD2NX-40: Fast Configuration
INFO -Elapsed time: 00 min : 10 sec
INFO - Operation: successful.
2
Output  Td Console
Figure 18: Programming the FPGA
o

23. Once the cable is detected and settings are set, program the device by clicking the Program Device icon
Figure 18.
24. Verify that:
o the LED’s [7:0] show the heartbeat of the system
o the sever-segment LED displays a hexadecimal counter with the decimal point LED also being turned on
whenever the count value equals F hex.
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REVISION HISTORY

Date Rev. # Author Change Description
3/18/2022 1.0.0 JA Initial Release.
4/17/2023 1.0.1 JB Completed porting App Note to Certus-NX-RT using Lattice Certus-NX
Versa Evaluation board LFD2NX-VERSA-EVN
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